
WorkExpo
M a n a g i n g  w o r k  e x p e r i e n c e  p r o g r a m s

 

 

 

 

 

 

 

 

 

G E T T I N G    S T A R T E D
 

Getting Started With WorkExpo | 1



 

Table Of Contents

1. Introduction 3

1.1. WorkExpo in a nutshell 4

1.2. Add New Student 4-5

1.3. Add New Employer 5

1.4. Create New Arrangement 5-6

2. Setting Up WorkExpo 7

2.1. School Details 7

2.2. Add/Edit Users 7

2.3. Block Dates 8

2.4. Default Dates 8

2.5. Optional Tabs 9

2.6. WorkExpo Options 9

2.7. Passwords 10

3. Finding Records 11

3.1. Find Student Records 11

3.2. Find Employer By Business Name 11

4. Printing 12

4.1. Sample Documents 12-13

4.2. Print Wizard 13-14

4.3. Print Work Experience Arrangement form(s) 14-15

5. What else can I do? 16

5.1. Import Student records 16

5.2. Import Employer records 16-17

5.3. Import signature images 17-18

5.4. Backup Data File 18-19

5.5. Exporting 19

5.6. Archiving Records And End Of Year Rollover 19-20

5.7. Generating Statistical Information 20-21

5.8. Networking WorkExpo 21

Getting Started With WorkExpo | 2



 

1 Introduction 

Getting Started With WorkExpo | 3



In simple terms there are three basics steps to creating a new student arrangement record within 
WorkExpo.  

 

Add a new student record in the Students window:

 

Add a new record for an Employer.

 

Finally, create the Arrangement between the student and employer

 

 

 

Some things to be aware of when adding records in WorkExpo

l Records are saved automatically but you can explicitly save a record by pressing the save button on 
the toolbar. 

l These three windows are the central work areas in WorkExpo and where you spend most time in 
WorkExpo. 

l It's important to understand that deleting an arrangement record DOES NOT delete the related 
student or employer records. 

l A student may have more than one arrangement. 

l An employer may have more than one student undertaking work experience at the same time. 

1.1 WorkExpo in a nutshell  

1.2 Add New Student
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To add a new student record manually:

1. In the Students window. 

2. Select "EDIT" then "Add new student" from the menu or click the STAR button on the WorkExpo 
ToolBar. 

3. Once you have added the details, the new record is saved automatically or you can click the save 
record button on the toolbar. 

To delete a student record:

1. In the Students window. 

2. Select "Delete student record" from the EDIT menu. 

3. The currently displayed student record will be deleted. 

4. The student record is deleted. 

 

 

To add a new employer record manually:

1. In the employer window. 

2. Select "EDIT" then "Add new employer" from the menu or click the STAR button on the WorkExpo 
ToolBar. 

3. Once you have added the details, the new record is saved automatically or you can click the save 
record button on the toolbar. 

To delete a employer record:

1. In the employer window. 

2. Select "Delete employer record" from the EDIT menu. 

3. The currently displayed employer record will be deleted. 

4. The employer record is deleted. 

Notes:

You can import employer records into WorkExpo from many external sources.

You can delete sample employer records easily. See Delete Sample Records (on-line 
documentation)

You can delete multiple employers with just a few clicks. See Deleting Employer records ('Delete 
Employer Records' in the on-line documentation).

The student and employer must already exist in WorkExpo before an arrangement can be created.
In the student or employer does not current exist then they will need to be added via the student or 
employer screens. 

To create a new arrangement in WorkExpo:

1. From the WorkExpo main menu click the Arrangements button. 

2. In the Arrangements window click the large NEW button at the top left of screen. 

3. A new (empty) arrangement record is created and ready for input. 

4. Place the cursor in the Student field and type the first few letters of the student's last name. 

When you delete a student or employer record all arrangements and other details associated with 
that student or employer are also deleted. WorkExpo will always warn you of this before deleting 
any records.

1.3 Add New Employer  

1.4 Create New Arrangement 
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5. WorkExpo finds the student and populates the field. 

6. Press the tab key on the keyboard. WorkExpo moves to the Employer field. 

7. Enter the first few letters of the employer name and press tab. 

8. Continue to complete the fields in the Arrangements window in this way. 

9. Once the record has been entered click the Save button on the toolbar or move off the record to 
another record.

 

 

 

The  minimum fields are student, employer, start date, end date and work type.
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On the School Details page you can enter the school details for your school or college. Enter the address 
details for the school, indicate what the public liability is and Principal name and Title. These details will 
appear on letters generated by WorkExpo.

Add/Edit/Delete WorkExpo Users:

In previous versions of WorkExpo the school phone numbers were stored with the school details. With the 
introduction of multiple-users in WorkExpo these details are now stored on a user-by-user basis. 

To add/edit or delete school phone, fax and email details:

1. From the WorkExpo main menu click the large Options button. 

2. In the school details section choose Add/Edit/Delete WorkExpo users 

3. Add or edit the details for each WorkExpo user. 

The phone, fax, mobile phone and email for the logged-in user will appear in all documents and letters.

How to add a password for a particular user:

1. Log into WorkExpo as the user you wish to set a password for.
Note that you can Log Off and change users without having to close WorkExpo. To do this choose Log 
Off from the File Menu. 

2. From the WorkExpo main menu click the large Options button. 

3. In the Options dialog click the Password tab. 

4. Add or edit the password for the logged-in WorkExpo user. 

Next time WorkExpo starts you will be prompted for a password. 
 

UsersTo add or edit a user in WorkExpo

l From the WorkExpo Main Menu, click the large Options button. 

l In the school tab, click the link to Add/Edit/Delete WorkExpo users.

 

 

The WorkExpo Users dialog box is displayed.

 

Here you can add, edit or delete WorkExpo users.

 

2 Setting Up WorkExpo  

2.1 School Details

You can add up to 5 users if you have a network licence.

2.2 Add/Edit Users
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WorkExpo will allow you to store and use an unlimited number of block dates. This will save typing the 
same dates in many times. Follow these steps to save your block dates in WorkExpo. Saved dates are 
available in the Arrangements Window and elsewhere. 

With the WorkExpo Main Menu on your screen click on the Options button. This will display the Options
dialog box. The Options dialog allows you to choose several option settings for WorkExpo so that the 
program can be setup to suits your working style and needs. Select the Block Dates tab and click OK.
The Block Dates dialog box will appear.

 

Enter your start and end dates for your block in the spaces provided. It is important to type dates in the 
following format at all times while using WorkExpo.

12/05/2005    Ensure you are using forward slashes between numbers
WORKEXPO will automatically save your block dates. Several different sets of dates can be saved.
Your block dates are now stored. They will appear in the ARRANGEMENTS window as drop down dates.   

 

In the Arrangements window you can set a default start date and a default end date so that each newly 
created arrangement record has the start date and end date filled in with your current block dates. You 
can also have a list of alternative dates to choose from in the start and end date drop down boxes.
 

To set a default start date and a default end date:

1. In the Arrangements window click the OPTIONS tab in the upper right of screen. 

2. In the section "Defaults for each new Arrangement" enter the start and end date you'd like each new 
arrangement to default to. 

3. You can double-click these date fields to pop-up a calendar. Choose a date from the calendar and 
click it and the selected date will appear back in the Arrangements window's default date box. 
 

To edit the dates which appear in the start and end date drop down boxes perform the following:

1. In the Arrangements window, click the large DATES button at the lower left of screen. 

2. This pops up the dates edit dialog box where you can add, edit or delete a series of start and end 
dates. Demo here (Section 2.3)

 

(Data File Corruption.html)

2.3 Block Dates

Most date fields in WorkExpo have a hidden calendar. Double-click the date field and a calendar will 
appear. Select a date in the calendar to write the selected date back into the date field.

If you have a typical two week block it is recommended that you enter the first Monday date. the 
First Friday Date, The Second Monday date and the second Friday date. This way you will have all 
key dates at your fingertips when choosing dates.

2.4 Default Dates

It is recommended that you enter all possible start and end dates which may occur during the year 
so that you can easily select a particular start date or end date from the drop down boxes. For 
example, if you have a two week block for work experience you should enter BOTH Monday dates 
as possible start dates and BOTH Friday dates as possible end dates. This will mean that when you 
are entering arrangement records for students undertaking one-week placements you will have the 
start end end dates readily available from the drop down boxes.
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In the students and employers window you can show or hide additional information for 
students/employers. This information is available on tabs which either are displayed or hidden depending 
on your choices in the Options tab. In this way WorkExpo allows you to hide any information which is not 
essential to the running of your program.

Settings for optional student information:

 

WorkExpo is very customizable and offers many options and settings so that you can spend the minimum 
time with data entry and the maximum time with analysis and outputs.

The following is a list of items or features which offer customization within the program including:

l Setting the date which appears on letters 

l Setting up your own user-defined fields 

l Maintining Work Type pick lists 

l Setting passwords for multiple users 

l Configuring warnings while you are working 

l Using an ink-jet printer 

l Show or Hide the School Details information in letters 

l Set up your own custom letters 

l Using signature images in letters 

l Warning you of various errors or possible conflicts while you work.

 

See the OPTIONS chapter in the WorkExpo Help File.

2.5 Optional Tabs

Option Description

DETAIL

Provides a DETAIL tab which shows detailed information for 
the current student. Fields such as gender and language 
spoken at home are available. To make this tab visible place 
a tick in the DETAIL check box.
See Setting Defaults ('Defaults - Student Background 
Detail' in the on-line documentation) for students.

PREFER

Displays a tab PREFER where students can indicate a 
preference for work experience. WorkExpo will try to match 
individual student preferences with employers.
See Student Preferences (on-line documentation)

TRACK

Displays TWO tabs called TRACK. On the left side of screen 
the TRACK tab is used to capture information relating to 
tracking a student's progress towards work placement. The 
other TRACK tab on the right of screen provides a matrix 
where tracking outcomes are visible. 
See Tracking Overview ('Tracking Students' in the on-
line documentation).

COUNSEL

Provides a tab where you can capture counselling information 
about students. Each counselling interaction can be captured 
to provide a counselling history on a student-by student 
basis.
See Counselling students (on-line documentation)

USER DEFINED
A tab where you can enter your own user defined fields 
(on-line documentation).

When tabs are hidden the information is not deleted only hidden.

2.6 WorkExpo Options 
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Passwords allow WorkExpo to be password protected. 

 

To set a password click Options / Password from the Main Menu.

 

 

 

2.7 Passwords 

To set or remove a password you must be logged in as the current user.
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You can find student records by Last Name or by First Name. You can enter the first few characters of 
the name and WorkExpo will try to find a match. For example type in "SAR" and WorkExpo will locate, for 
example, "SARAH" or "SARA". WorkExpo sorts the records into Last Name order if you search by last 
name and first name order if you search by first name. This means that if the first record found is not the 
one you're looking for you can page through the records using the PAGE DOWN key.

 

1. In the Students window, select the MAIN tab. 

2. Choose to search by Last Name or by First Name by selecting the appropriate check box. 

3. Enter the Name of the Student and press enter. 

4. WorkExpo finds the student and shows the student record. 

5. Press the PAGE DOWN key to see the next closest match.

 

You can find an Employer by Name or by *PART* of the employer or business name. You can enter the 
first few characters and WorkExpo will try to find a match. For example type in "COMM" and WorkExpo 
will locate, for example, "Commonwealth Bank".

 

1. In the Employers window, select the GENERAL tab. 

2. Enter the Name of the Employer and press enter. 

3. WorkExpo finds the employer and shows the employer record in the list.

 

OTHER WAYS TO FIND EMPLOYERS:

l You can also Search Employers by Work Type ('Search Employers By Work Type' in the on-line 
documentation) to find a list of employers who offer a particular type of work. 

l You can also Search Employers by Key Word ('Search Employers By Key Word' in the on-line 
documentation) e.g. BANK to find all employers with "Bank" in the business name. 

l You can also Find Employers by using the FIND tool ('Find Employer Using the Find Tool' in 
the on-line documentation) e.g. Find employers where the contact first name is "Robert".

 

 

3 Finding Records

3.1 Find Student Records

You can also Find Students by using the FIND tool ('Find Students Using the Find Tool' in 
the on-line documentation) e.g. Find students where the post code = "1234".

3.2 Find Employer By Business Name  
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WorkExpo can generate the following documents.

 

Employer report form                                   Work experience arrangement form

4 Printing  

4.1 Sample Documents
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You can print all these documents directly from WorkExpo.

 

Use the Print Wizard to print:

l Multiple documents for an individual student. 

4.2 Print Wizard
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l Multiple copies of a single document for multiple students. 

l Lists and Reports. 

l Documents for Visiting Teachers. 

l Work Experience Arrangement Forms. 

l Statistics relating to work experience. 

l Mailing labels for employers. 

l Blank work experience arrangement forms. 

l Student and employer certificates. 

l Custom one-off letters to employers. 

l ...and more

 

How to start the Print Wizard:

l Click the large Print button on the main menu OR 

l Choose Print Wizard from the File menu.

 

Sorting and filtering results using the Print Wizard:

You can sort the results in the Print Wizard by choosing the sort order on the last page of the wizard.

You can specify a particular year level or homegroup or use a custom group ('Custom Student 
Groups' in the on-line documentation).

You can use date parameters in many reports.

 

 

 

The Print Wizard gives you the most options when it comes to printing from WorkExpo.

4.3 Print Work Experience Arrangement form(s)

What to do

 

Notes

 

1.  With the WORKEXPO main 
menu on your screen click on 
the PRINT button. 

WORKEXPO can print on the official department forms or print a facsimile.

2.  The Print Wizard dialog box 
will appear. You can choose to 
print an arrangement form for 
an individual student or a 
group of students.

In this example we will print 
for a group of students.

Select the print for “several 
students…” option

Click NEXT
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3.        Select “WE 
Arrangement forms” and click 
NEXT

 

4.        Select students You can select students by date or alternatively print forms for all 
students in WORKEXPO

5.        Select to print on 
official department forms.

Do this by clicking “I want to print on official department forms”. 
Choosing this option will print data only, so that you print on the official 
forms.

6.        Choose Preview or print 
and click FINISH
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You can import records into WorkExpo from any external electronic record keeping system. You must, 
however, do this as a 2 step process.

Export the required records from your school's database system to an Excel file. Import this file into 
WorkExpo, using the Import wizard (File menu)

Select Import Student (or Employer) records. Follow the Import Wizard's instructions on screen. 

 

How to import student records:

1. In WorkExpo, start the import wizard from the File / Import menu.

2. Print the list of fields required in Step 2 of the Import wizard. Then cancel the wizard. 

3. Contact your school's central database administrator.

4. Give the field list to the database administrator and request an export file of all Year x records.

5. Request that all fields set out in the field list are included.

6. Open the export file using Microsoft Excel.

7. Format the file as set out in the field list instructions.

8. Once the Excel file has been saved with an .xls extension, re-start the WorkExpo import wizard and 
follow the instructions. 

 

 

Import - employersYou can import employer records into WorkExpo from any external electronic system.

You must, however, do this as a 2 step process.

l Export the required records from your system to an Excel file in .xls format

l Import this file into WorkExpo by choosing  Tools / Wizards /Import wizard

l Select Import Employer records option from the Import wizard.

l Follow the Import Wizard's instructions on screen.

 

EMPLOYER FIELDS (Full List)

 

5 What else can I do?

5.1 Import Student records

You can import student records in a special update import to update records reather than replace 
them.

5.2 Import Employer records 

Export employer records to an XLS spreadsheet, then use that spreadsheet as a template for your 
import.

BusinessName

ContactSalutation

ContactFirstName

ContactInitial

ContactLastName
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Letters which appear in WorkExpo, including the letter to parent and letter to employer can have your 
signature embedded in the document.
This will save you time if there are multiple letters to sign. The format of the signature must be a image 

EmplAddress

EmplSuburb

EmplPostalcode

EmplWorkPhone

EmplFaxPhone

EmplMobilePhone

TypeOfWE

EmplNote

StateSchool?

LetterName

ReservedText

ReservedDate

ReservedBoolean

ReservedNumber

EmplMailAddress

EmplMailSuburb

EmplMailPostalcode

EmplEmail

EmplWebSite

EmplIndustrySector

EmplIndustrySectorSub

EmplSize

EmplStatus

EmplAttend

EmplWorkSafety

EmplDress

EmplMultiSite

EmplOther

EmplDateCreated

ContactTitle

UserDefinedE1

UserDefinedE2

UserDefinedE3

UserDefinedE4

UserDefinedE5

EmplStartTime

EmplEndTime

EmplRate

 Export employer records to an XLS spreadsheet, then use that spreadsheet as a template for your 
import.

5.3 Import signature images
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format (Bitmap .bmp) 
Check the WorkExpo CD for a sample signature image file called UserSig.bmp in the ..Manual 
Install/Common folder

You can use Windows PAINT program to view your image file before saving.

 

Follow these steps to import your signature into WorkExpo:

1. Sign your signature on a small piece of paper.

2. Scan the signature and save it as a Windows bitmap file (.bmp)

3. Save the file in MS PAINT as a Windows Monochrome bitmap.

4. The image size should be about  1.76 cm wide by about 1.00 cm tall
or about  200 x 100 pixels. In PAINT choose IMAGE / ATTRIBUTES to check the size.

5. Save the file with a .bmp extension.

6. Start WorkExpo and click the “Options” button from the main menu. 

7. Click the “Signatures” tab. 

8. Select signature being imported – either teacher or principal. 

9. Enter the path and filename to the signature.

10. Click the “Import Signature” button.

Check the available options under “Use/Include signatures” . WorkExpo stores the signature internally in 
the database for future use.

You can also export a signature file, if necessary, from WorkExpo. 
You may wish to do this to check if the signature is correct.

IMPORTANT NOTE: You should regularly back-up your data.

Your data file stores all information you enter into WorkExpo. The default file  name is DATA.MDB

This file by default is located in c:\program files\workexpo\data.mdb

To backup this file you can copy it using Windows Explorer tools or WorkExpo can create backups for you.

Follow these steps to backup your WorkExpo data file:

1. From the WorkExpo main menu choose the large Options button. 

2. Click the Back-up tab. 

3. The Backup Options dialog box will be displayed.

4. In the File To Be Saved box enter the DATA.MDB file and its path. This is the file which stores all your 
WORKEXPO data, including student, employer and arrangement data. 

5. In the Save As box enter the location and name of the backup. The location must pre-exist on your 

5.4 Backup Data File  
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system but the name for the Save As backup file can be new. You can also choose to be reminded to 
backup on close. 

6. Click CLOSE or press ESC to close off the dialog box and save changes.

 

NOTES:

l Remember that ALL your data is stored in a single file - DATA.MDB If you have a reliable recent 
backup of this file you can completely restore WorkExpo with a minimum of fuss. 

l It is recommended that you backup to a network location. This is typically the most secure form of 
backup. 

l You can tell WorkExpo to prompt you to backup when exiting the program. You can also restore from 
a previous backup. Click the restore tab. 

l Also be aware that you can browse and use an existing data file. Choose Open from the File menu.

 

 

You can export from WorkExpo. Use the Export wizard for best results.

To start the Export wizard choose Export from the File menu.

 

Also be aware that all data for WorkExpo is stored in a single file, by default:

c:\program files\workexpo\data.mdb

If you have a copy of Microsoft Access you can open this file directly and copy and paste rows from the 
tables.

 

 

WorkExpo will also automatically save a daily copy of each backup for each day of the week in the 
same folder you nominate. Optionally you save multiple copies of the file. Check the Automatic 
Multiple Backups tab in the Options dialog.

5.5 Exporting  

5.6 Archiving Records And End Of Year Rollover

What to do

 

Notes

 

1. With the WORKEXPO main 
menu on your screen click the 
TOOLS menu then choose 
WIZARDS then ARCHIVE 
wizard.

WORKEXPO can archive student records, employer records or 
arrangement records. This helps maintain your database.

2.  The Archive Wizard dialog 
box will appear. You can choose 
to archive arrangement 
records, student records or 
employer records.
In this example we will archive 
student records.

Select “Work Experience 
Arrangement records”

Click on the NEXT button...
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StatYou can print multi-school reports and graph detailed Work Placement information across a range of 
schools for analysis.

For example, assuming you have imported several schools' data files into WorkExpo; you can gather 
statistical information for placement type and employer size by school. Follow these steps to generate 
this information.

 

1. From the WorkExpo main menu click the large Print button to start the Print Wizard. 

2. Choose Miscellaneous / Program Statistics

3. In the Program Statistics dialog box under Show Statistics For , choose Arrangements, then By 
Placement Type, Employer Size and School

3.       Select the records you 
wish to archive in the box. WORKEXPO archives records by form or year level group.

4.    Click ARCHIVE Your records are now stored in an archive. You can browse the archive at 
any time by clicking the ARCHIVE button then selecting “I’d like to 
browse the archives”
NOTE: Records can be restored or deleted from the archive. 

5.7 Generating Statistical Information
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4. WorkExpo will calculate the statistics for the request and display them in the wizard. 

5. You have the option of printing these statistics by clicking the Finish button which will send the 
details to the printer or... 

6. Alternatively you can chart the statistics by selecting them and then copying to the clipboard. (Ctrl + 
C or choose COPY from the right-click shortcut menu) and then... 

7. Pasting them into Excel and pressing the F11 key. The F11 key in Excel will generate a graph or chart 
of the statistics.

 

 

WorkExpo is a Microsoft Access runtime database. It consists primarily of two key files (databases) -
WORKEXPO.MDE (front-end) and DATA.MDB (back-end).  It should be installed so that the data file may 
be shared by different users at different sites while all the program files (incl. front-end) reside on the 
local machine.

WorkExpo can automatically create a connection to a back-end file on a network drive. You do not need 
to copy files manually.

1. Install WorkExpo normally on any machine and accept all defaults.

2. Register the software in the usual way. Register via Options/School

3. Start WorkExpo.

4. From the WorkExpo main menu click the “Options” button.

5. Click the “Network” tab:

6. Specify the path to the folder in the "Network Server data file location" box, then 

7. Click the "Create Network Connection" button.

WorkExpo will carry out the following steps:

l Checks to see if a WorkExpo data file (DATA.MDB) exists in the specified network location.

l If an existing data file is found in the specified network location, WorkExpo connects to it and 
renames the data file on local machine to data.old

l If an existing data file is NOT found in the specified network location, WorkExpo copies the 
current data file on the local drive to the specified server and then connects to it. Then WorkExpo 
renames the old data file to data.old

NOTES:

l It is recommended that you use a UNC (Universal Naming Convention) connection rather than a 
mapped drive connection to the data file. 

l Creating a network connection may result in somewhat slower performance as the data has to be 
gather across the wire rather than from a fast hard disk. 

l If the Network is down WorkExpo will not function and will prompt the user for the location of the 
data file. This may confuse some users.

l You can use FILE /Open to navigate to a different WorkExpo data files.
 

5.8 Networking WorkExpo
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